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About this manual 

This PRO.FILE manual uses various signs and icons in order to guarantee a good 

readability and comfortable handling. 

For quicker finding within the manual, step-by-step instructions are marked with a 

margin heading. 

Menu sequences and function calls 
Menu sequences and function calls explained in this 

manual are marked in bold and in quotation marks. 

 Example:  

"File" => "New" => 

"Document description" 

Buttons and keys 
Keys and buttons are highlighted by angle brackets. 

 Example:  

"Confirm with <OK>." 

Notes and warnings 
To highlight special information the following icons are used: 

 

 

Function call: 

"PRO.FILE" => "Extras" => "Options" => "Performance" 

 

 

Example: 

Boxes marked with this icon give subject-relevant examples for the usage of command 

lines, configuration strings and other software-relevant entries. 

 

 

Note: 

Boxes marked with this icon contain useful hints on the operation, configuration or 

installation of the PRO.FILE software. 

 

 

Attention: 

All information given in these boxes is very important and should be read carefully! 

Non-observance of these hints may lead to wrong functioning, display problems or 

other negative consequences. 

 

 

Important notes:  

The "stop sign" warns you of possible entry or operation errors, which may lead to loss 

of data! 

 

 

Attention – Undo not possible: 

All entries and configurations described in these boxes have to be made carefully, 

because they cannot be undone! 

 

Step-by-step 

instructions: 
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1 The integration PRO.FILE – AutoCAD Plant 3D 

PRO.FILE PLM speaks the language of design departments and offers functions needed 

by design engineers. 

PRO.FILE is an established PDM system for the administration of data and documents 

for the technical office. It works fully integrated into the CAD System AutoCAD Plant 3D. 

Drawings and CAD models can be loaded from or saved to PRO.FILE directly from 

AutoCAD Plant 3D. 

When projects, sub-projects or drawings are saved, PRO.FILE automatically generates 

document structures and proofs of usage. These can be included in the drawing title 

block along with the product data. 

Interfaces allow the transfer of product data (part master data and CAD documents) 

specified during the design process with AutoCAD Plant 3D to ERP systems. 

 

The following chapters describe the operation of PRO.FILE within the CAD system 

AutoCAD Plant 3D. 

The descriptions assume that the functions of the PRO.FILE basic software are known or 

can be looked up in the corresponding manual. 

This documentation describes the interface between PRO.FILE and AutoCAD Plant 3D. 

The following topics will be addressed:  

 Operation of PRO.FILE from within AutoCAD Plant 3D 

 Data representation of structures/references in PRO.FILE 

 Integration of PRO.FILE into the AutoCAD Plant 3D environment 

 

 

Note: Manual "CAD design supported by PRO.FILE" 

When using the integration PRO.FILE – AutoCAD Plant 3D, please also note the 

manual "CAD design supported by PRO.FILE", which describes the basic procedures 

and related issues from the designer's point of view. 

 

 

Note: Plant projects and sub-projects ≠ PRO.FILE projects 

In PRO.FILE it is possible to assign part and document descriptions to PRO.FILE 

projects. These are not the projects used in AutoCAD Plant 3D but the object type 

"Project". Projects from AutoCAD Plant 3D are saved via part and document 

descriptions. 

It is, however, still possible to link the document structure resulting from an AutoCAD 

Plant 3D project to a PRO.FILE project via the default structure functions of PRO.FILE. 

 

The contents of 

this manual  
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2 Let's get started: First steps with the PRO.FILE 

integration 

Via the loading, saving and information functions of the PRO.FILE integration, the user 

can access information in and functions of PRO.FILE directly from AutoCAD Plant 3D. 

The basic functions of the integration are explained in the following chapters: 

 Only upon first start: Setting up the local work folder 

 Where can I find the functions of the PRO.FILE integration? 

 How to log in to PRO.FILE? 

 A brief overview: The functions of the integration 

 

2.1 Only upon first start: Setting up the local work folder 

CAD drawings are loaded directly from PRO.FILE in AutoCAD Plant 3D, and also saved 

from AutoCAD Plant 3D directly to PRO.FILE. For this, the drawings are saved 

intermediately on the user computer in a "work folder". 

The local saving of the CAD drawings makes sure that all required parts and documents 

required for working with the CAD drawing are available on the user computer. 

 

 

Note: Local work folder is always required 

The AutoCAD Plant 3D features require the availability of all related data. Without 

defining a local work folder, it is not possible to work with the integration PRO.FILE – 

AutoCAD Plant 3D. 

 

You can freely choose the local work folder at the first start of the integration. 

1. If no local work folder is defined when the integration is started, an input screen 

will prompt you to define this folder. 

Proceed as 

follows 
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2. You now have to specify a "root folder". The 

root folder is the superior folder of the local 

data storage. In this folder you can later create 

several work folders, which are then 

supervised by the "Workcenter". 

 The "root folder" can be selected - or created 

via the button <Make new folder>. 

3. Once you have selected the desired root 

folder, confirm with <OK>. 

 

4. In the second step, "work folders" are now created in this root folder, which will 

then be used by the integration.  

 Consequently, you are now prompted to specify a work folder within the root 

folder: 

5. Please specify a name for the 

work folder. 

6. Confirm your entry with 

<OK>. 

 The configuration of the 

Workcenter is now finished. 

 

 

This work folder and other local work folder can be created and managed by the user 

via the Workcenter. The Workcenter can be accessed via the PRO.FILE menu in 

AutoCAD Plant 3D under "Extras" => "Workcenter". 

Detailed information can be found in the chapter "Extras: The Workcenter". 

  



Functions of the Integration PRO.FILE AUTOCAD Plant 3D Where can I find the functions of the PRO.FILE integration? 

PRO.FILE Release 8.7 
June 2017 Page 9 of 70 

2.2 Where can I find the functions of the PRO.FILE integration? 

The functions of the PRO.FILE integration can be accessed directly in AutoCAD Plant 3D 

via the menu "PRO.FILE": 

1. Start "AutoCAD Plant 3D" 

2. Go the menu bar to the section "PRO.FILE". 

3. Select the desired integration function from the menu. 

 

Whenever one of these menu functions is used, PRO.FILE is activated. According to the 

function used, the required windows in PRO.FILE are opened automatically. 

The user can thus access the whole range of PRO.FILE database commands with all 

possibilities for data management. 

 

2.3 How to log in to PRO.FILE? 

If you access a PRO.FILE function for the first time within an AutoCAD Plant 3D session, 

you have to log in to PRO.FILE. 

Via the logon, the user is now identified by his PRO.FILE user name and password. 

Based on this logon, the user rights, start statuses and function access rights for the 

logged-on user are activated. 

In the login screen, please enter: 

 Your PRO.FILE user name 

 Your PRO.FILE password. 

Confirm with <LOGIN>. 

The PRO.FILE home screen is now 

displayed. 

 

 

 

Note: No login required in case of "Autologin" 

This login is not requested, if the PRO.FILE autologin function is activated. 
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2.4 A brief overview: The functions of the integration 

This chapter gives you a brief overview of the possibilities offered by the menu functions. 

Detailed information on each function can be found later in this manual. 

 "Open": 

Only entire projects can be opened in Plant3D. It is, however, possible to update 

sub-projects or drawings at a later point, by loading them into the active project via 

the function "Open". If a sub-project is selected via the function "Open", its structure 

is updated in the local project structure, but no drawing is opened. If a drawing is 

selected via the function "Open", this drawing is opened and activated in AutoCAD 

Plant 3D. 

 "Update": 

The "Update" function corresponds to the function "Open" with the difference that 

the user does not have to select a plant project in PRO.FILE (since the project 

already has to be opened). The data record of the project currently opened in 

AutoCAD Plant 3D is used. 

 "Open with version browser": 

Via the version browser you can decide for each component of the project structure 

the version to be loaded. 

 "Open as stored": 

This function opens the Plant project in the constellation of component versions it 

has last been saved in. 

 "Open with newest versions": 

This function opens a Plant project or sub-project with the newest available versions 

of the contained components (sub-project, drawings). 

 "Open with newest released versions": 

This functions opens a Plant project or a sub-project with the newest released 

versions of the contained components (sub-projects, drawings). This function is only 

available if a released version actually exists for each of the contained components. 

 

 "Plant project", "Sub-project" 

Via the functions "Save Plant project" and "Save Sub-project" the currently active 

project or sub-project is saved to PRO.FILE. If the plant project has not been saved 

to PRO.FILE before, a document description (and, depending on the configuration 

also a part description) is then created for the affected objects. 

 "Project automatically", "Sub-project automatically" 

Via these functions the currently active project or sub-project is saved to PRO.FILE. 

Document and part descriptions for all components are created in PRO.FILE 

automatically without query. File names and properties can be configured to be 

transferred automatically into specific PRO.FILE fields. 

 "Managed Version" 

This function allows for the targeted creation of versions of the different 

components or sub-structures or the entire project. 

Group "Open" 

Group "Save" 
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 "Part assign" 

Via this function it is possible to assign PID-Objects in P&ID-drawings specific part 

master records in PRO.FILE. In this context, it is possible to use existing part master 

records for the assignment or to create new parts in PRO.FILE. 

 

 "Update properties": 

Via this function the properties of the plant project are updated with the metadata 

of the project and the drawing in PRO.FILE. If the drawing is then opened via the 

project manager browser, the updated properties are also transferred into the 

referencing text fields of the drawing. This update is not made automatically if the 

drawing was already opened. 

 "Create bill of materials": 

With this function all PRO.FILE part master records that have been assigned to PID 

objects within the plant project are summarized in PRO.FILE in a bill of materials. 

 "Lock/Unlock": 

Via these functions the project, the sub-project and drawings can be locked by one 

or several users. 

After one of the functions has been selected, the lock/unlock screen is displayed 

with the document structure. 

 "Delete database relation": 

With this function, the relation of the entire Plant project to the PRO.FILE database 

can be deleted. The project (including all it sub-components) is then treated as a 

local project that has not yet been saved to PRO.FILE. 

 "Make pipe specification available": 

SpecSheets for pipes can be saved and administrated centrally in PRO.FILE. With 

the function "Make pipe specification available" it is then possible to select the pipe 

specification from PRO.FILE, so that it is referenced by the project and does not 

have to be saved anew for each project. 

 

Via the functions in this menu group you can display information on the current project 

and contained documents. 

 "Document list": 

Displays the local project structure, the local status and the PRO.FILE status of the 

documents. 

 "Project more…" 

 "Part structure": Displays the structure of the part descriptions created for the 

active project in PRO.FILE. 

 "Part form": Displays the part description for the active project in PRO.FILE. 

 "Bill of materials": This function is not available in the current version of the 

integration. 

Group "Edit" 

Group "Display" 
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 "Document list PRO.FILE": Displays the documents contained in the current 

project structure in list form in PRO.FILE. 

 "Document structure": Displays the document structure of the project in 

PRO.FILE. 

 "Document form": Displays the document form of the project in PRO.FILE 

 

 "Save": 

Via the function "Save drawing", the active drawing is saved to PRO.FILE. If the 

drawing has not been saved to PRO.FILE before, a document description (and, 

depending on the configuration also a part description) is then created for the 

affected objects. 

 "Save automatically": 

Via this function the currently active drawing is saved to PRO.FILE. The document 

description for the drawing is created in PRO.FILE automatically without query.  

 "Save as new version": 

With this function, a new version of the active drawing, which is already saved in 

PRO.FILE, can be created and saved to PRO.FILE. 

ATTENTION: The local project structure is updated by this process, but the project 

structure in PRO.FILE remains unchanged until the changed sub-project and the 

Plant project with the updated structure are saved to PRO.FILE. 

 "Save NDF": 

With this function, a neutral data format (e.g. tiff, pdf) is created from the CAD 

document and saved as new document in PRO.FILE. This NDF document is 

automatically linked to the document description of the drawing. 

 "Lock/Unlock": 

Via these functions, the active drawing can be locked or unlocked by using the 

lock/unlock dialog. 

 "Display more…" 

 "Document list": Displays the structure, the local status and the PRO.FILE status 

of the current drawing. 

 "Document list PRO.FILE": Displays the document of the active drawing and its 

structure (XRefs) in a list in PRO.FILE. 

 "Document structure": Displays the document structure of the current drawing in 

PRO.FILE. 

 "Document form": Displays the document description of the current drawing in 

PRO.FILE. 

 "Document usage": Displays the document usage of the current drawing in 

PRO.FILE. 

  

Group "Handle 

active drawing" 
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 Workcenter: 

All files loaded or saved via the PRO.FILE integration in AutoCAD Plant 3D are 

automatically saved locally in the Workcenter folder. With this function you can 

manage these files or create additional work folders. 

 

Detailed information on the individual functions and their usage can be found in the 

following chapters. 

Group "Extras" 
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3 Functions for opening CAD documents from PRO.FILE 

in AutoCAD Plant 3D 

PRO.FILE manages CAD data centrally and makes tehm available to users with the 

corresponding access permissions via the command "Open". 

This chapter explains the functions and possibilities in 

the context of opening documents: 

 

 Open: Loading documents from PRO.FILE into AutoCAD Plant 3D 

 Working with the Checkout wizard to search for CAD documents 

 Open with newest and released versions of linked CAD documents 

 Attention: Opening of locally existing files 

 

 

Attention: 

The data loaded from PRO.FILE in AutoCAD Plant 3D are not automatically locked 

when opened in AUTOCAD PLANT 3D. The user has to lock the objects manually via 

the function "Lock". 

After the object has been edited and saved back to PRO.FILE, it can be unlocked 

again, so that it is available to other users.  

For detailed information see the chapter "Lock/Unlock". 

 

 

Note: PRO.FILE checks permissions 

When the function "Open" is used for documents from PRO.FILE, the corresponding 

access rights of the user are checked. These permissions depend on the user access 

rights as well as on the status-dependent permissions of the document. 
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3.1 Open: Loading documents from PRO.FILE into AutoCAD Plant 3D  

If you want to access a project, sub-project or a drawing from PRO.FILE, you have to 

open the entire project first. Use the function "Open" of the PRO.FILE – AutoCAD Plant 

3D integration menu for this. 

 

 

Note:  

The PRO.FILE menu in AutoCAD Plant 3D is only available if at least one drawing is 

opened. If required, create a new empty drawing. 

 

The open functions start the PRO.FILE Checkout wizard, in which you can select the 

desired document description of the project for loading in AutoCAD Plant 3D. 

 

Select the PRO.FILE function "Open" 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Open" => "Open" 

 

1. Go into the menu bar of AutoCAD Plant 3D into the menu 

"PRO.FILE". 

2. Select the menu entry "Open". 

 "Open" loads documents as they were saved the last time in 

PRO.FILE.  

 The Checkout wizard for the selection of documents is displayed. 

 

Select the desired document in the Checkout wizard 

The Checkout wizard displays the PRO.FILE GUI as it was used the last time. 

Step 1 

Step 2 
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3. If the desired 

document is not yet 

displayed in a list or 

form view, you can 

start a selection via 

the following 

functions: 

 Via the tab 

"Cockpit". 

 Via the search 

function in the 

icon bar. 

 Via favorites, 

SmartSearch or 

task assignment. 
 

4. If the desired document is displayed in a list view, you can select it. (If the desired 

document is displayed in a form view, it is already selected. 

5. Click <Open>. 

 The Checkout wizard closes and the project is opened in AutoCAD Plant 3D. 

 

Detailed Information on the Checkout wizard can be found in the following chapter 

"Working with the Checkout wizard to search for CAD documents". 

 

You want to edit? Then you must lock the document(s) 

Until now, the selected CAD data are not locked in PRO.FILE and can be modified by 

other users in PRO.FILE. 

This means: If you want to edit the CAD document, you have to lock it. 

  

Step 3 



Functions of the Integration PRO.FILE AUTOCAD Plant 3D Open: Loading documents from PRO.FILE into AutoCAD Plant 

3D 

PRO.FILE Release 8.7 
June 2017 Page 17 of 70 

The "Lock" dialog supports you in this process: 

 If you click on 

"Lock" the dialog 

for locking CAD 

documents is 

displayed. 

(Information on 

the functions and 

status indicators 

can be found in 

the chapter "The 

document list") 

 

6. Select all documents you want to lock with the corresponding check 

boxes. 

7. Confirm your selection with <OK>. 
 

 

 The selected documents and its components are now opened in AutoCAD Plant 

3D. The process of opening a document is now finished. 

Detailed information on the locking of documents can be found in the chapter 

"Lock/Unlock". 

 

 

Note: Why can you not lock a document? 

You want to open a document for editing, but in the "Lock" dialog, you cannot activate 

the corresponding checkbox? 

This may have two reasons: 

 The document is already locked by a different user. You can see who the locking 

user is by selecting document in PRO.FILE and looking at the dependent tab 

"Status information". 

 The document is in a workflow status, in which you are not allowed to edit the 

document. This is typically the case for "released" documents. 

 

For detailed information on the "Open" process, please see the following chapter: 

 Working with the Checkout wizard to search for CAD documents 
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3.1.1 What happens at the file level when a plant project is opened? 

A plant project is saved in PRO.FILE as a zip file to the document description of the 

project. This zip file contains the complete folder of the project including the sub-folders 

and all non-referencing files. 

To the document descriptions of the sub-projects, the database files (.dcf, .dcfx) 

referenced in the plant project are saved. The drawings referenced in the sub-projects 

are saved to the document descriptions of the drawings. 

When opening a plant project from PRO.FILE the folders contained in the zip file are 

created locally in the working folder and their contents are extracted. 

Then, the remaining referenced files of the sub-projects and drawings are copied to the 

project folder. A collision check is then made. If there are locally changed files, they are 

displayed in a list and can either be overwritten or kept. 

 

3.1.2 Working with the Checkout wizard to search for CAD documents 

If you use the function "Open" from the PRO.FILE integration, you have to select the 

document to be opened in the Checkout wizard. 

The aim of this procedure is: 

 For PRO.FILE to know which document is opened, the desired document 

description must  

 either be selected in a list view or a structure browser 

 or be displayed in a form view 

 Then the button <Open> at the right bottom of the Checkout wizard has to 

clicked. 

 

Prerequisite for the selection/activation of a document in PRO.FILE is that the document 

is displayed in a list or form view. 
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When the Checkout wizard is opened, the PRO.FILE GUI is displayed as it has been 

used the last time:  

If search results had 

previously been opened in 

a list or form view in a 

separate tab, you can 

directly access the 

displayed documents. 

If the desired document is 

displayed on a tab, select it 

and click <Open>.  

 

If no search had been 

made previously, or if the 

desired document is not 

displayed on one of the 

existing tabs, you can now 

search for it. 

For this, several functions, 

which are explained in the 

following, are available: 

 

 

 

Attention: Double-click in the Checkout wizard 

Documents are selected and then opened via the <Open> button. A document 

cannot be loaded via a double click! 

Because a double click means: Open document for viewing! 

The checkout will remain active in the background waiting for your selection. But only 

if the checkout wizard is closed, the document can be used for editing in PRO.FILE. 
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To search for data records in the Checkout Wizard, several options are available: 

 Searching via the tab "Cockpit" 

The same icons as in the icon bar can be found on the tab "Cockpit": "Search 

document", "Full-text search", "Search part", "Search project" have the same function 

as the icons in the icon bar. 

You can always go back to the tab "Cockpit". 

 

 Search via the functions of the favorites bar 

The favorites bar also offers several ways of searching for a document: 

 Via the "Favorites" memorized searches or data lists can be accessed with a 

double click. 

 With the "SmartSearch" you can create individual search forms. 

 If you are working with PRO.FILE processes and tasks, you can access the 

documents linked to a task or process via the task or process structure. 

 

 Search via the icon bar 

In the superior icon bar you can start a search via the following buttons: 

 : Search for document descriptions to be displayed in a list. 

 :   Search for parts to be displayed in a list. Documents linked to 

the part can be displayed in the dependent tabs "Structure" or "Document list". 

 : Search for projects to be displayed in a list. Documents linked to the 

project can be displayed in the dependent tabs "Structure" or "Document list". 

 

Detailed information on the selection of data in PRO.FILE can be found in the manual 

"Operation PRO.FILE for Beginners ". 

 

  

Searching for 

data records in 

the Checkout 

Wizard 
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3.1.3 Open sub-projects and drawings 

The opening of a sub-projects or drawings is actually an update, since this is only 

possible when the entire project is already in the Workcenter folder and opened in 

AutoCAD Plant 3D. 

If a drawing has an offline change, a corresponding message is displayed during the 

open process and the user can then update the corresponding sub-project. 

Before the loading in the Workcenter folder, a collision check is made, showing a 

dialog where you can select local documents to be overwritten with the status from 

PRO.FILE. 

Sub-projects or drawings can be opened from PRO.FILE. 

1. Go into the menu bar of AutoCAD Plant 3D into the menu 

"PRO.FILE". 

2. Select the menu entry "Open". 

 "Open" loads documents as they were saved the last time in 

PRO.FILE. 

 

 The Checkout wizard for the selection of documents is displayed. 

The further proceeding for the opening of sub-projects/drawings is identical to 

the proceeding for the opening of plant projects, as described in the chapter 

"Open: Loading documents from PRO.FILE into AutoCAD Plant 3D". The 

difference, however, is that instead of a document description of a plant project, 

you select the document description of a sub-project or drawing. 

 

3.2 Update 

The update function corresponds to the function "Open" for projects with the following 

differences: 

 You do not have to select a plant project in PRO.FILE. The record of the currently 

opened plant project is used. 

 In the dialog for the collision check, which displays the documents to be copied 

from PRO.FILE, all documents locked by the current user are not selected and 

cannot be selected for copying. 

This way, you can update your local status with data from PRO.FILE without losing 

changes to documents locked by you. 

 

 

Attention: 

If the function "Open" is used instead, e.g. to load (i.e. to update) a sub-project, 

locked documents can be overwritten as well. 

 

Proceed as 

follows 
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3.3 Open with newest and released versions of linked CAD documents 

 

To open files from PRO.FILE, 

the user can choose from three 

options: 

 Open as stored 

 Open with newest versions 

 Open with newest released 
versions 

 

 

 

Note:  

The latter two options do not refer to the Plant project to be opened from PRO.FILE. 

They refer to the objects contained in the project (sub-projects and drawings) from 

PRO.FILE. As a user, you can decide with which version status you want to open the 

components linked to the project 

 

The different options are: 

 "Open as stored" 

The selected plant project (or sub-project if a plant project is already open) is 

opened from PRO.FILE as it was saved the last time. Linked CAD documents are 

loaded with the version status, as they were saved the last time via the PRO.FILE 

integration. 

 "Open with newest versions" 

If the Plant project or sub-project contains links to other CAD documents (sub-

projects or drawings) in PRO.FILE, the newest versions of these linked CAD 

documents are loaded. 

When the function "Open with newest versions" is used for opening a project or 

sub-project, PRO.FILE checks, whether the project contains components for which 

versions exist. If this is the case, the newest visible version of such a component is 

loaded in the AutoCAD Plant 3D session.  

 "Open with newest released versions" 

The selected project or sub-project is loaded with the newest, released versions of 

the linked sub-projects or drawings. The newest versions that are in a release status 

are loaded. 
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When the function "Open with newest released versions" is used for opening a 

project or sub-project, PRO.FILE checks, whether the project contains components 

for which versions in a release status exist. If this is the case, the newest visible 

version in a release status of such a component is loaded in the AutoCAD Plant 3D 

session. 

 

 

Attention: 

The function "Open with newest released versions" can only be used, if a released 

version actually exists for each of the contained components (sub-projects, drawings). 

If this is not the case, the open process is aborted with a message, saying that no 

released versions were found. 

 

The actual process of opening the document is identical for all three of these options. 

For more information see the previous chapter "Open: Loading documents from 

PRO.FILE into AutoCAD Plant 3D". 

 

 

Note: 

Only the versions, for which the user has the viewing permission can be displayed. If 

the most recent version is not "visible" for you, you will get the newest version visible 
for you. 
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3.4 Open with version browser 

With the version browser you can open projects in dynamic constellations. You can 

define via the version browser with which version a project and its components are 

opened. 

The function "Open with version browser" works similar to the function "Open" – with the 

difference that the version browser is displayed after the checkout wizard. 

 

The version browser is divided into two areas: 

 In the upper structure windows the selected CAD document is displayed with all 

attached components. 

 Via the button <Expand all> you can you can display the entire structure of the 

project to be opened. 

 The field "Loaded" shows the current opening type of the CAD elements displayed in 

the structure window – without manual version selection. The opening type affects 

the display of these elements: 

Via the button <Change…> you can choose between the four options for 

opening: 

 Open "as stored" 

 Open "newest version" of the components 

 Open "newest released version" of the components. 

 Open "newest released version or newest version" of the components, 

depending on their availability. 

 In the lower window the different versions of a component are listed. 

 You can select the version of the component that you want to open. 

The document 

structure (top) 

The version 

window (bottom): 
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Function call:  

"PRO.FILE" => "Open more…" => "Open with version browser" 

 

1. Select the "PRO.FILE" menu from the menu bar in AutoCAD Plant 3D. 

2. Select the function "Open with version browser". 

 The Checkout wizard is displayed. 

3. Select the desired CAD document and click on the <Open> button. 

 The Checkout wizard closes. 

 The screen "Select document" is displayed. 

4. Select the component, for which you want to make a version selection, in the 

document structure.  

 The lower version window now displays all corresponding versions. 

5. By toggling the radio button in the first column of the version window you can 

activate the desired version of a CAD element. 

6. Having activated all desired versions, you can leave the version browser by clicking 

<Open> in order to continue the loading process. 

 The screen "Lock" is displayed. 

 At this moment, the selected CAD data is not yet locked in PRO.FILE and still 

available for other users. This means: If you want to edit the CAD data, you have to 

lock it. 

7. Select all documents you want to lock by setting the checkmark for it in the first 

column. Detailed information on the locking of documents can be found in the 

following chapter "Lock/Unlock". 

8. Confirm your selections with <OK>. 

 The selected CAD components are opened in Inventor. The process of opening 

with the version browser is now finished. 

 

  

Proceed as 

follows 
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3.5 Attention: Opening of locally existing files 

When a CAD document is opened, all required elements and components are loaded 

into the current work folder. 

If the work folder already contains a file of the same name, you will get a list of the 

elements that are to be overwritten. This also applies for newer or older versions of a 

CAD documents, which can now be overwritten. 

 

 

Attention: 

If locally changed files are overwritten with files from PRO.FILE, these local files and all 

changes to them are irretrievably lost! 

If versions are overwritten, the locally existing assembly now point to the newly loaded 

version which has replaced the original version! You should therefore be careful when 

deciding to overwrite a locally existing version. 

 

A dialog will inform you that "Locally existing files" were found. You can now select, 

which of the locally existing files are to be loaded anew from PRO.FILE and thus be 

overwritten. 

The list also shows whether files have been changed locally and thus no longer match 

the document loaded from PRO.FILE. The list also shows version differences. 

You now have to options: 

 By selecting the corresponding files and confirming the action, all files are copied 

to your work folder. 

 You can activate a different work folder via the command "PRO.FILE" => "Extras" 

=> "Workcenter" => "Activate" in order to prevent the overwriting of the files. 

 

 

Note: 

Due to this behavior it is absolutely necessary, that the file names in PRO.FILE are 

unique. Otherwise, it may happen that a "plant" 1234 is overwritten with another 

variant 5678 also named "plant". 

 

A drawing exists 

already in the 

work folder? 
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4 Saving CAD documents to PRO.FILE 

For the first-time saving of CAD documents, as well as for the saving of changes from 

the local Workcenter to PRO.FILE, the following functions are available: 

In the ribbon category "Save" In the ribbon category "Handle 
active drawing" 

  

 Save Plant project 

 Save Sub-project 

 Save Project automatically 

 Save Sub-project automatically 

 Managed Version 

 Part assign 

 Save Drawing 

 Save Drawing automatically 

 Save as new version 

 Save NDF 

 

The basic procedure of saving differs according to whether the CAD data are saved in 

PRO.FILE for the first time, whether existing documents are opened for editing and 

saved back to PRO.FILE, or whether new versions of documents are to be saved to 

PRO.FILE. 

The description is therefore divided into three chapters: 

 Save Plant project: Saving CAD objects for the first time 

 Saving changed CAD documents to PRO.FILE 

 Saving of new versions 

 

The description of the procedure and the possibilities can be found in the following 

chapters. 

Additional information on the saving of files and the usage of the Checkin wizard can 

be found in the manual "Operation PRO.FILE for Advanced". 

 

 

Note: Manual "CAD design supported by PRO.FILE" 

When using the integration PRO.FILE – AutoCAD Plant 3D, please also note the 

manual "CAD design supported by PRO.FILE", which describes the basic procedures 

and related issues from the designer's point of view. 
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 "Save": 

Via the functions "Save Project", "Save Sub-project", "Save Drawing", the opened 

project, the active sub-project or the active drawing is saved to PRO.FILE. 

First, all open drawings are saved locally. The open but not activated drawings are 

closed. 

The project folder, or parts of the project folder are then packed to zip files and copied 

to PRO.FILE. 

The drawings referenced in the sub-projects are directly saved to the document 

descriptions of the drawings and excluded from the zip files. 

The corresponding document structure is built. 

If a project, sub-project or drawing already has a project relation, it is a change to be 

saved. It is then checked whether you have the permission to save the affected object. 

A document list is displayed, in which all savable documents are listed. All non-savable 

documents cannot be selected in this list, and thus cannot be saved. 

 

 

Note:  

For new projects, the entire project has to be saved to PRO.FILE first, since the project 

folder is then copied to the Workcenter folder (if it is not already there) and a 

consistent structure is built in PRO.FILE. 

To ensure this, a check is made when a sub-project / drawing is to be saved, whether 

the superior plant project is already known in PRO.FILE. If this is not the case, an error 

message is displayed. 
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4.1 Save Plant project: Saving CAD objects for the first time 

With the use of the function "Save Plant project", you can save the entire AutoCAD Plant 

3D project, with all sub-projects, drawings and related files to PRO.FILE.  

 

 

Note: 

For new projects, the entire project has to be saved to PRO.FILE first, since the project 

folder is then copied to the Workcenter folder (if it is not already there) and a 

consistent structure is built in PRO.FILE. 

To ensure this, a check is made when a sub-project / drawing is to be saved, whether 

the superior plant project is already known in PRO.FILE. If this is not the case, an error 

message is displayed. 

 

The action "Save" takes place in several steps, with different dialogs being displayed, 

depending on the results of the previous step 

 

 

Note: 

The description of the processes in connection with PRO.FILE may vary from your 

actual business situation. This is due to the fact that actions, which are executed after 

the execution of a command, can be configured differently in PRO.FILE. This 

particularly applies to the PRO.FILE areas of status administration, part and project 

assignment, change management and change history. 

 

To save a plant project from AutoCAD Plant 3D to PRO.FILE for the first time open the 

function "Save Plant project". 

 

 

Function call: 

"PRO.FILE" => "Save" => "Save Plant project" 

 

1. Select the menu "PRO.FILE" from the menu bar. 

2. Click on the "Save…" button.  

 

 The Checkin wizard is displayed, which will support you in the proper saving of 

your plant project. 

 

Proceed as 

follows 
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Saving of new objects in PRO.FILE takes place in three Steps: 

 Checkin wizard Step 1: Creating or assigning a part master record in PRO.FILE 

 Checkin wizard Step 2: Creation of the document description in PRO.FILE 

 Checkin wizard Step 3: Assignment of the created objects to a PRO.FILE project 

 

These steps are described in the following sub-chapters. 

 

4.1.1 Checkin wizard Step 1: Creating or assigning a part master record in PRO.FILE 

By default, every CAD document in PRO.FILE is linked to a part master record. The part 

master record consists of attributes and is used for the creation of bills of materials, for 

the display of data in the drawing title block, for transfer to an ERP/PPC system, etc. 

 

 

Note: Usage of PRO.FILE parts 

If you are not using PRO.FILE parts but only PRO.FILE documents, you can skip this 

step with the button "Document without part". 

 

In the first step, the assignment of the CAD document to be saved to a PRO.FILE part 

master record has to be made. 

Note: If several CAD 

documents are being saved, 

the title bar of the Checkin 

wizard displays the documents 

that is currently being 

handled. 

 

 

  



Functions of the Integration PRO.FILE AUTOCAD Plant 3D Save Plant project: Saving CAD objects for the first time 

PRO.FILE Release 8.7 
June 2017 Page 31 of 70 

The Checkin wizard offers different options, which can be accessed via the operations 

bar of the wizard screen: 

 

 

Usage:  

 A new part description is to be created for the new document. 

 The document to be saved is automatically linked to the new part description 

afterwards. 

Proceeding: 

1. Fill in the attributes (fields) for the description of the part master. 

2. After entering all required part data, confirm the creation of the part master record 

in PRO.FILE with <Next>. The new part master record is saved. 

 

Usage: 

 The document to be saved is not to be linked to a new part master record but to an 

existing part master record. 

 It is possible to link several documents to one and the same part master record. 

Proceeding: 

1. Click the option <Select in list> to select the desired part description. 

 The wizard displays the PRO.FILE surface, as it was opened the last time. 

2. If the part master record desired for assignment is not yet displayed in a list or form 

view, you can use the search functions of the home page, the icon bar or favorites 

and SmartSearch to start a selection. 

3. If the part master record desired for assignment is displayed in a list view, you can 

now select it. (If the desired part master record is displayed in form view, it is 

already selected automatically). 

4. Confirm your selection with <Next>. 

 

 

Usage: 

 The document to be saved is not to be linked to a new part master record but to an 

existing part master record. 

 The desired part master record is not yet displayed in PRO.FILE and has to be 

searched for before assignment of the document. 

  

Create new: 

Select in list:  

Search: 
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Proceeding: 

1. Click the option <Search> to select the desired part description. 

2. Enter the search criteria into the displayed search form and click <Search>. 

3. Select the desired part master record from the list of results. 

4. Confirm your selection with <OK>. 

 

 

Usage: 

 A new part description is to be created for the new document. 

 To make the creation of a new part master record easier, an existing part master 

record can be used as template with pre-filled fields, which only need to be 

adjusted. 

 Example of usage: You are creating several records for the same screws, only with 

different lengths. If you do not want to enter the same data over and over again, 

you can use the function "New using template" and only have to adjust the filed 

"Screw length". 

 The document to be saved is automatically linked to the new part description 

afterwards. 

Proceeding: 

1. Click the option <New using template> to select the desired part description. 

 The wizard displays the PRO.FILE surface, as it was opened the last time.  

2. If the part master record desired as template is not yet displayed in a list or form 

view, you can use the search functions of the home page, the icon bar or favorites 

and SmartSearch to start a selection. 

3. If the part master record desired for assignment is displayed in a list view, you can 

now select it. (If the desired part master record is displayed in form view, it is 

already selected automatically). 

4. Confirm the selection of the part description with <Next>. 

 The input form for the creation of the part master record is pre-filled with the data 

from the selected part master record. 

5. Make the necessary adjustments to the pre-filled data. 

6. Once all required part data is entered, confirm the creation of the new part master 

record in PRO.FILE with <Next>. The new part master record is saved. 

  

New using 

template: 
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Usage: 

 For special usage purposes it may be necessary to create a document description 

without the link to a part master record. 

 You can therefore use this option to skip the creation or selection of the part master 

record and to proceed directly with the saving of the document description. 

Proceeding: 

1. Click the option <Document without part>. 

 The Checkin wizard for parts is skipped. The Checkin wizard for the document 

description is displayed. 

 

4.1.2 Checkin wizard Step 2: Creation of the document description in PRO.FILE 

All files saved in PRO.FILE are generally stored under the object type "Document". 

In order to save the CAD file now to PRO.FILE, the corresponding document description 

must be entered to describe and classify the CAD document and to make it available for 

further usage. 

For this, the Checkin wizard for the document description is available: 

Note: If several CAD 

documents are being 

saved, the title bar of the 

Checkin wizard displays 

the documents that is 

currently being handled. 

 

 

  

Document without 

part: 
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Here, too, the Checkin wizard offers different options that can be accessed via the 

operations bar: 

 Create new 

 New using template 

 

 

Usage and proceeding for these options are the same as for the assignment of the part 

master record, only that these functions here relate to the document description. 

For detailed information see the previous chapter "Checkin wizard Step 1: Creating or 

assigning a part master record in PRO.FILE". 

 After the finalization of your entries confirm the saving of the CAD document and 

the assignment to the desired part master record with <Next>.  

 The CAD document is now saved in PRO.FILE. 

 

The Checkin wizard now continues with the options of assigning the newly created 

objects to a PRO.FILE project. 

 

4.1.3 Checkin wizard Step 3: Assignment of the created objects to a PRO.FILE project 

In this step the CAD data just saved can be assigned to a specific PRO.FILE project. 

 

 

Note: Usage of PRO.FILE projects 

The third step in the Checkin wizard is intended for the use of PRO.FILE projects. If you 

are not using PRO.FILE projects, you can skip this step with the option <Skip>. 

 

For this project assignment of the newly created document description (and, if created, 

the new part master record) an existing project must be selected, or a new project must 

be created. 
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Note: If several CAD 

documents are being 

saved, the title bar of the 

Checkin wizard displays 

the documents that is 

currently being handled. 

 

Here, too, the Checkin wizard offers different options that can be accessed via the 

operations bar: 

 

 

 

Attention: Project must be activated 

In order for a CAD document to be linked to a project, this project must be 

ACTIVATED. This means that for all of the following options, you have to select the 

option "Activate" afterwards.  

 

The proceeding for these options is the same as for the first two steps of the Checkin 

wizard: 

Create new: 

A new project is created in PRO.FILE. The part master record and 

document description created in steps 1 and 2 are assigned to this new 

project. 

 

Search: 

The part master record and document description created in steps 1 

and 2 are to be assigned to an existing project. This project is now 

searched via the search form and selected. 

 

Select in list: 

The part master record and document description created in steps 1 

and 2 are to be assigned to an existing project. This project is already 

displayed in a PRO.FILE list and only has to be selected and confirmed. 
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Activate: 

If a project is activated, all new parts and documents in PRO.FILE are 

automatically assigned to this project. If no project is currently activated, 

and you want to do so, you can use this function to activate a project. 

 

Deactivate: 

Again: If a project is activated, all new parts and documents in 

PRO.FILE are automatically assigned to this project. If this assignment is 

not to be made for the current document, you can deactivate the project 

before finalizing the saving process. 

Note: If a project is activated, this is displayed in the title bar of the 

active PRO.FILE window. 

 

 

For the assignment of new CAD to a project via the Checkin wizard Proceed as follows 

1. Select an existing project or create a new one. 

2. Select this project in the list view (project in form view are automatically selected). 

3. You now must select "Activate". Only if the selected project has been activated, the 

assignment to the project is made after confirmation. 

4. Confirm your proceeding with <Finish>. 

 The saving of the CAD data in PRO.FILE is now finished. 

  

Proceeding: 
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4.2 Save sub-project 

Via the function "Save Sub-project" you can save a sub-project with all contained 

drawings and related files to PRO.FILE. 

 

 

Note: 

For new projects, the entire project has to be saved to PRO.FILE first, since the project 

folder is then copied to the Workcenter folder (if it is not already there) and a 

consistent structure is built in PRO.FILE. 

To ensure this, a check is made when a sub-project / drawing is to be saved, whether 

the superior plant project is already known in PRO.FILE. If this is not the case, an error 

message is displayed. 

 

Consequently, the function "Save Sub-project" is only reasonable and available for the 

saving of changes to a sub-project (adding of drawings, saving of drawing changes). 

Further information can be found in the chapter "Saving changed CAD documents to 

PRO.FILE". 

 

4.3 Save drawing 

Via the function "Save Drawing" you can save a drawing with all referenced drawings 

and related files to PRO.FILE. 

 

 

Note: 

For new projects, the entire project has to be saved to PRO.FILE first, since the project 

folder is then copied to the Workcenter folder (if it is not already there) and a 

consistent structure is built in PRO.FILE. 

To ensure this, a check is made when a sub-project / drawing is to be saved, whether 

the superior plant project is already known in PRO.FILE. If this is not the case, an error 

message is displayed. 

 

Consequently, the function "Save Drawing" is only reasonable for the saving of changes 

to a sub-project (adding of drawings, saving of drawing changes). Further information 

can be found in the chapter "Saving changed CAD documents to PRO.FILE". 

If the function "Save Drawing" is applied to a drawing newly created within the sub-

project, the drawing is saved to PRO.FILE but not assigned to the sub-project in 

PRO.FILE. To make this assignment later, the sub-project has to be saved as well. 
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4.4 Saving changed CAD documents to PRO.FILE 

After changes have been made to a CAD document opened from PRO.FILE you can use 

the "Save" functions to save your changes back to PRO.FILE.  

If you use one of the "Save" functions for objects already existing in PRO.FILE, the object 

in PRO.FILE is changed. 

 

 

Attention: 

PRO.FILE blocks concurring changes during the work with the CAD system. It is 

therefore important to make sure that the objects are locked for other users. For this, 

the function "Lock" is available, offering the user exclusive access to the document and 

allowing the user to save back his/her changes. 

If the document has not been locked and has been modified by a different user in the 

meantime, who has changed back his/her changes to PRO.FILE, your changes cannot 

be saved back to PRO.FILE. See chapter "Lock/Unlock". 

 

You can choose between the following functions to save changes to a CAD document 

back to PRO.FILE: 

 "Saving changed CAD documents to PRO.FILE" =(Modify) 

 "Save automatically" (see following chapter).  

 

This chapter describes the proceeding for the saving of changes. 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Save" => "Plant project" 

"PRO.FILE" => "Save" => "Sub-project" 

"PRO.FILE" => "Handle active drawing" => "Save Drawing" 

 

 When "Save" => "Plant project" is used, all changes to the entire project, including 

sub-projects and drawings, are saved. 

 When "Save" => "Sub-project" is used, all changes to the active sub-project, 

including drawings, are saved. 

 When "Handle active drawing" => "Drawing" is used, only changes to the active 

drawing are saved. 

 

1. Go to the integration menu "PRO.FILE" in AutoCAD Plant 3D. 
Proceed as 

follows 
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2. Select the desired "Save" function from the area "Save". 

 PRO.FILE recognizes the CAD document as a PRO.FILE object and automatically 

goes into change mode. 

 

Selection of the documents to be saved 

 The dialog for the 

selection of CAD 

documents to be 

saved is 

displayed. 

(Information on 

the functions and 

status information 

can be found in 

the chapter "The 

document list"). 

 

 The dialog displays a list with all changed CAD documents from the current 

AutoCAD Plant 3D session. 

 For assemblies, the structure is analyzed for changed CAD documents and the list 

of all documents of this assembly is preselected. 

 For this list the access permissions for saving the changes of the user are checked. 

(If the CAD document had been locked before for editing, this prerequisite is 

fulfilled.) 

3. Select all documents you want to save in PRO.FILE. To do so, 

activate the checkboxes for the desired documents. 

4. Confirm your selection with <OK>. 
 

 The changes are then saved. The CAD document in PRO.FILE is thus overwritten. 

 

Optional: Enter modification comment 

5. Depending on the configuration 

and PRO.FILE status, you now 

have to enter a modification 

comment.  

Enter the comment information 

into the fields on the dialog 

screen. 

 

6. Confirm your modification comment with <OK>. 

 The modification comment screen is closed; your modification comment can now 

be found in the "Modification list" in PRO.FILE. 
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Locking/unlocking the saved documents 

 The dialog for 

documents to be 

unlocked after 

saving is 

displayed.  

(Information on 

the functions and 

status information 

can be found in 

the chapter "The 

document list"). 

 

 If documents from PRO.FILE had been locked for editing in AutoCAD Plant 3D, 

this lock is not automatically removed after saving. The documents remain locked 

and cannot be changed by other users. 

 If you are finished with your changes to the CAD document, you can now unlock 

the document to make it available for other users. 

7. To make this process easier, the PRO.FILE CAD documents that are still locked 

are displayed in the list.  

To make the documents available again for other users, select the documents in 

the list. To do so, activate the checkboxes for the desired documents. 

8. Confirm your selection with <OK>. 

 The lock flag for the selected documents is now removed. 

 The saving of your changes to PRO.FILE is now finished. 

 

 

Note: Further changes after unlocking 

Please note that if you want to make further changes to your CAD document, you have 

to lock them again, as described in the chapter "Starting your changes: "Lock" the CAD 

document". 
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4.5 Save automatically 

Apart from the already described menu functions <Save> the integration offers the 

function <Save Project automatically>, <Save Sub-project automatically> and <Save 

Drawing automatically>, which is a very comfortable way of saving documents to 

PRO.FILE: 

 This function allows the automatic creation of documents and parts in PRO.FILE. 

 Descriptions (metadata, classifications) have to be entered for the first document 

and part in PRO.FILE. All sub-documents and sub-parts are then created 

automatically in PRO.FILE. 

 The difference to the function "Save" is that no query for part and document 

information is made after the first document and part. 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Save" => "Project automatically" 

"PRO.FILE" => "Save" => "Sub-project automatically" 

"PRO.FILE" => "Handle active drawing" => "Drawing automatically" 

 

 

Note: 

"Save automatically" is identical to "Save", with the difference that the metadata is only 

queried for the first document and part. 

 

As result of the action <Save automatically>, a part and document description is 

created for each CAD document in PRO.FILE, including the correct structure of the 

assembly and the bill of materials. 

 

 

Attention: "Required fields" and <Save automatically> 

For all automatically created CAD documents (sub-projects, drawings), the values that 

are to be entered via the Checkin wizard do NOT exist. This is also the case for fields 

defined as required fields. As a result, all documents created automatically have to be 

classified in detail at a later point in time, especially if field information is required for 

the transfer to other systems (ERP integrations)! 
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4.6 Saving of new versions 

With the PRO.FILE AutoCAD integration it is possible to create new versions when 

saving CAD documents. 

 With the function "Save as new version" in the category "Handle active drawing" a 

version can only be created from the active drawing. The versioning of projects and 

sub-projects is not possible via this function. 

 Via the function "Managed Version" you can create versions of any desired number 

of components of a project (including the project itself). 

Both functions require that the object to be versioned is already saved in PRO.FILE. The 

detailed proceeding is described in the following sub-chapters. 

 

4.6.1 Save as new version 

If the function "Save as new version" is used, PRO.FILE creates a new version of the 

active drawing and increases the version/revision counter for this document accordingly.  

 Only this active drawing is versioned. 

 The old version remains in PRO.FILE. 

 The new version is saved with a new document ID in PRO.FILE and displayed in 

AutoCAD Plant 3D. 

 Within a project/sub-project the local reference is switched to the new version of 

the drawing. 

 A new version can only be created of the newest version of a drawing. Example: A 

new version of a drawing "Version 2" cannot be created if a "Version 3" of this 

drawing already exists. Instead, you would have to open and activate "Version 3" to 

create a new version (provided that version 3 is the newest version). 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Handle active drawing" => "Save as new version" 

 

1. Make sure that the drawing, of which you want to create a version, is opened and 

active in AutoCAD Plant 3D. 

2. Go to the integration menu "PRO.FILE" in AutoCAD Plant 3D. 

3. Select the function "Save as new version" from the area "Handle active drawing". 

Proceed as 

follows 
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4. If you have not opened the newest 

version of this drawing, but want to 

create a new version from an older 

version (provided that this is allowed for 

you), the setting of the parameter "Ask 

when creating version from an older 

version" determines whether a dialog is 

now displayed. 

5. If you want to create this version from 

an older version, confirm the dialog with 

<Yes>. 

 

 A new version of the active CAD 

document is now saved in PRO.FILE. A 

message will inform you of the 

successful creation of the version. 

 The new version is displayed in 

AutoCAD Plant 3D. 

 

 

 

Attention: New version is not locked 

The new version that has just been saved in PRO.FILE is not locked. To lock the 

document please use the function "Lock/Unlock". 

 

The document list always displays the most recent version. To display older 

versions/revisions of a document you can use the dependent tab "Versions" of the 

document description in PRO.FILE. 

 

4.6.2 Managed Version 

The function "Managed Version" is used for the creation of versions within project 

structures. These functions support the following requirements: 

 Contained components (sub-projects, drawings) are included in the process 

 The file name of the versioned project components remain unchanged. 

 

Please note the following for "Managed Version": 

 By selecting a component for "Managed Version", this component is included in the 

process of version creation. Sub-components of this selected component (sub-

projects and drawings) are not automatically versioned as well – they need to be 

selected individually. Per definition, all versions of a component have the same file 

name. 
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 Components that are not selected are not versions. If, for example, a sub-project is 

versioned but not its drawings, the new version of the sub-project will still refer to 

the old version of the not selected drawings. 

 The versionability of the components is checked at the beginning of the "Managed 

version" process. If a component cannot be versioned (e.g. already released or a 

newer version exists already), it cannot be selected. In such a case, the version 

dialog displays an icon and a tooltip on the cause of the problem. 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Save" => "Managed Version" 

 

1. Open the project, the structure of which you want to use for "Managed Version" via 

the project managed. 

2. Select the function "Save" => "Managed Version" from the "PRO.FILE" menu of the 

integration. 

 The Managed Version wizard is displayed. 

 The integration 

detects the 

structure of the 

project based on 

the current CAD 

document. 

 

 The wizard displays the detected project structure, so that you can select the 

documents you want to create a version of. 

 The top node and the first level are expanded. Further levels can be expanded via 

the corresponding structure  icon. 

 The column "Info" contains additional information, e.g. if a component cannot be 

versioned. By moving the mouse pointer over the error icon, a tooltip is displayed 

explaining the cause. 

 The "Status" columns show the current editing status of an object in the workcenter 

folder and in PRO.FILE (see chapter: Up to date or not: Display of status 

information) 

Proceed as 

follows 
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3. Select: Select all components you want to create a version in PRO.FILE 

of. To do so, activate the checkbox next to the component. 

 

4. Once you are done, confirm with <OK>. 

 An overview of all 

documents selected for 

versioning is displayed. 

5. Confirm this list with 

<OK>. 

 New versions are now 

created of all selected 

components. 

 

 The successful creation of the new version(s) is 

confirmed by a message. 

6. Confirm this message with <OK>. 

 

 A final list shows 

the document 

(sub-projects), 

that have been 

changed locally 

as a consequence 

of the version 

creation. 

 

7. In this list please select all documents to be saved by activating the corresponding 

checkbox. 
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8. Confirm your selection with <OK>. 

 The process "Managed Copy" is thus finished. 

 

4.7 Save NDF (neutral data format) 

 

 

Note: 

The function <Save NDF> is not a standard feature in PRO.FILE. This means that you 

need a license to use this function. Furthermore, specific installations (converter) and 

configurations may be required on your system. 

 

The integration PRO.FILE AutoCAD Plant 3D offers the possibility to convert an 

AutoCAD Plant 3D drawing into a neutral format (e.g. PDF, Tiff, …) and to save this 

document in PRO.FILE. 

By using the function "Save NDF" a neutral format document is created and then 

attached automatically to the part master record of the drawing.  

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Save" => "Save NDF" 

 

 By using the function "Save NDF" a neutral format document is created from the 

CAD drawing. 

 For this NDF document, a document description is created in PRO.FILE and 

automatically linked to the document description and/or part description of the 

drawing. 

 

 

 

Attention: Function only available with PRO.FILE Format Generators 

The function <Save NDF> is only available in connection with the PRO.FILE Format 

Generators. Furthermore, specific installations (converter) and configurations may be 

required on your system. 

 

  



Functions of the Integration PRO.FILE AUTOCAD Plant 3D Part assign 

PRO.FILE Release 8.7 
June 2017 Page 47 of 70 

4.8 Part assign 

The function "Part assign" facilitates the administration of the relation between PID 

objects in the drawing to part master records in PRO.FILE. This relation is then also 

displayed in the Data Manager of AutoCAD Plant 3D. 

 

 

4.8.1 Assignment of PID objects and part master records 

Part master records from PRO.FILE can be assigned to an object in your P&ID drawing.  

 

 

Function call from the PRO.FILE-menu in AUTOCAD Plant 3D: 

"PRO.FILE" => "Save" => "Part assign" 

 

1. In your drawing, select one or more PID objects, 

for which you want to make a part master record 

assignment. 

 

2. From the area "Save" of the integration menu select the function "Part assign". 

Note: If you did not select an object in the first step, you are now prompted by 

AutoCAD Plant 3D to select objects. 

 The screen for the assignment of PRO.FILE part master records is displayed. 

Proceed as 

follows 
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 The left-hand area of this window lists the properties of the active PID object. 

The right-hand area lists the PID objects selected in the first step. The column 

ProfileID is empty, provided that no assignment has been made so far. 

3. You can now make the assignment as follows: 

 

If no part master record exists in PRO.FILE for this PID object so far 

1. Click on the button "Save part" . 

 The Checkin Wizard for the creation of part master records is displayed in 

PRO.FILE. 

Option 1 
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2. Here you can enter the describing data for the PRO.FILE part. 

3. Confirm your entries with <Finish>. 

 

If there is already a part master record in PRO.FILE for this PID object 

1. Click on the button "Assign part" . 

 The PRO.FILE wizard for the selection of an existing part master record is displayed. 

 

2. Here you can select the desired part master record from a form/list display (if the 

desired part master record is not yet displayed in a list/form, you can start a search 

for it via the tab "Cockpit"). 

3. Confirm your selection with <Open>. 

 

Option 2 
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 You will receive the following result for both possibilites: In the window for the 

assignment of part master records, the column "ProfileID" now shows the ID of the 

PRO.FILE part master record. 

 

 

 

4. If you want to make further assignments for other PID objects, please repeat the 

steps above accordingly. Otherwise, you can confirm your assignments with 

<OK>. 

 The selected PID objects are now assigned part master records from PRO.FILE. This 

information is also displayed in the data manager. 

 

 

Attention: Manual assignment without wizard 

You can also make the assignment of a PID object to a part master record manually 

without the wizard – by entering the ID of the part master record into the field 

"ProfileID" – but then you have to make sure that this part master record ID actually 

exists and belongs to the correct part. 

 

 

Note: 

To undo the assignment of a single part master record to a PID object, it is sufficient to 

delete the part master record ID from the field "ProfileID". As soon, as you close the 

window with <OK>, the change is applied. 

 

4.8.2 Further functions for the assignment of PID objects and part master records 

To make the assignment of PID objects and PRO.FILE part master records easier, the 

window for the assignment offers further functions: 

 

These functions have the following effects; 

 "Save part" in the dropdown box "Action to selected lines": 

If several objects are selected in the list of PID objects, this function can be used to 

create part master records for all selected objects in PRO.FILE and assign them. 
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Further information can be found in the chapter "Collective assignment of PID 

objects and part master records". 

 "Search part" in the dropdown box "Action to selected lines": 

If several objects are selected in the list of PID objects, this function can be used to 

automatically select part master records for all selected objects in PRO.FILE and 

assign them. Further information can be found in the chapter "Collective 

assignment of PID objects and part master records". 

 "Detach part": 

Via this function, the assignment of all PRO.FILE part master records is undone for 

all selected PID objects. 

 "Show part": 

If this function is applied to a single selected PID object (to which a PRO.FILE part is 

already assigned), PRO.FILE opens and displays the corresponding part in a form 

display. If the function is applied to several selected objects via the dropdown box 

"Action to selected lines", PRO.FILE opens and displays the corresponding parts in a 

list display. 

 

All actions you want to perform via the dropdown box "Action to selected lines" have to 

be confirmed afterwards via the button . 

 

4.8.3 Collective assignment of PID objects and part master records 

To make the assignment of PRO.FILE parts to PID objects easier, the assignment can 

also be made as a collective process via the dropdown box "Action to selected lines". 

 

Automatically create part master records in PRO.FILE for PID objects 

1. In the list of PID objects, select all objects for which you want to create parts in 

PRO.FILE. 

2. From the dropdown box "Action to selected lines", select the function "Save part" 

and confirm with the button . 

 The parts are created in PRO.FILE and assigned to the PID objects. 

 

Proceed as 

follows 
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Attention: Automatic creation of part master records 

Since the part master records are created without further user interaction, it has to be 

made sure that all required information (name, etc.) is transferred automatically to the 

part master record form. This may be necessary because: 

 the part master records would otherwise require post-editing, or 

 the part master record form may contain required fields. 

In the latter case, an automated creation of part master records without automatic 

transfer of required information is not possible. 

For the automated transfer of information to the PRO.FILE part master record a 

corresponding configuration of the parameter "Copy parameters from CAD to 

PRO.FILE" (internal name _38_AUTOPAR_CFG) is required in the PRO.FILE 

Management Console. Details can be found in the configuration manual of the 

integration. 

If necessary, contact your administrator. 

 

Automatically assign existing parts in PRO.FILE to the corresponding PID objects 

1. In the list of PID objects, select all objects for which you want to make part 

assignments in PRO.FILE. 

2. From the dropdown box "Action to selected lines", select the function "Search part" 

and confirm with the button . 

 PRO.FILE now searches for parts matching the defined criteria (see warning below) 

of the PID objects. If such parts are found, they are automatically assigned to the 

corresponding PID objects. 

 

 

Attention: Automatic assignment of part master records 

Since the part master records are to be assigned without further user interaction, it has 

to be made sure that the corresponding parts are found in PRO.FILE based on 

specified criteria. 

For this, the correct configuration of the parameter "Automatic assignment to existing 

part master record" (internal name _38_PART_MATCH_FIELDS) is required in the 

PRO.FILE Management Console. Details can be found in the configuration manual of 

the integration. 

If necessary, contact your administrator. 

 

  

Proceed as 

follows 
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5 Edit: Additional functions of the integration 

The integration menu "Edit" offers various different functions for the editing of your 

documents. 

 

These functions are described in the following sub-chapters: 

 Update properties 

 Create bill of materials 

 Lock/Unlock 

 Delete database relation 

 Make pipe specification available 

 

5.1 Update properties 

In AutoCAD Plant 3D, certain text fields in the drawing reference to the properties of the 

plant project. 

The synchronization of these text fields is made indirectly via the update of the properties 

of the plant project. 

Via the function "Update properties" the properties of the plant project are updated with 

the metadata of the project and the drawing in PRO.FILE. If the drawing is then opened 

in the project manager, the updated properties are also transferred to the referencing 

text fields of the drawing. This update of the drawing is not made automatically if the 

drawing was already opened. 

Furthermore, there is the possibility to synchronize field contents with the PRO.FILE 

document description of the drawing by attribute blocks. For this, the function "Update 

properties" must be used while the drawing is opened and active. 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Edit" => "Update properties" 

 

After this function is used, all contained elements of the drawing legend (title block, 

modification list) is filled with data from PRO.FILE. 

Within the modification list, always the most recent entries are listed. 
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This function does not require any further interaction from the user. 

5.2 Create bill of materials 

In the P&ID drawings and 3D drawings you can assign the various PID objects part 

master records from PRO.FILE – in which case you can either use existing part master 

records or create new ones. Furthermore, the integration allows the creation of a bill of 

materials from al part master records that have been assigned to PID objects in the 

above way. 

During the creation of the bill of materials, the integration checks the number of 

occurrences of the various objects: if an object occurs several times within a drawing 

and is always assigned to the same part master record, the object is only listed once in 

the bill of material (one position) but with an accordingly increased number of units 

(e.g. pieces). 

As BOM header, the PRO.FILE part master record the document description of the plant 

project is linked to is used. 

 

 

Function call from the PRO.FILE menu in AUTOCAD Plant 3D: 

"PRO.FILE" => area "Edit" => "Create bill of materials" 

 

Creation of a bill of materials for a plant project: 

1. Open the plant project from PRO.FILE. 

2. Make sure that the plant project (i.e its document description in PRO.FILE) is linked 

to a part master record (see chapter "Checkin wizard Step 1: Creating or assigning 

a part master record in PRO.FILE"). 

3. Make sure that the PID objects that are to be part of the bill of materials are linked 

in PRO.FILE to the corresponding part master records (see chapter "Part assign"). 

4. In the menu bar of the PRO.FILE integration, in the area "Edit", select the function 

"Create bill of materials". 

 The bill of materials is now built from all PID objects that have been assigned a 

PRO.FILE part master record and is saved in PRO.FILE. For this process, please 

note the following: 

 For the creation of the bill of materials, all plant class objects that have a filled 

field "ProfileID" and are either part of the P&ID or the Plant 3D sub-project. 

 If several plant class objects have the same PRO.FILE part master record ID 

and the same plant tag, they are only listed once in the bill of materials. 

 If several plant class objects in the Plant 3D sub-project have the same 

PRO.FILE part master record ID but different plant tags, they are summarized 

under one position with a quantity > 1 (according to the number of their 

occurrences). 

  

Proceed as 

follows 
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 If several plant class objects in the P&ID sub-project have the same PRO.FILE 

part master records ID but different plant tags and do not exist in the Plant 3D 

sub-project they are summarized under one position with a quantity > 1 

(according to the number of their occurrences). 

 The bill of materials is now saved in PRO.FILE. 

 

5.3 Lock/Unlock 

If you want to edit a CAD document and save your changes back to PRO.FILE, the 

document has to be locked for other users before you start your changes. 

 To "Lock" the document is the only way to make sure that a document is opened for 

editing by several users at the same time, thus making concurring changes. 

 With "Unlock" the CAD drawing is made available to others again for editing. 

For detailed information see the following sub-chapters: 

 Starting your changes: "Lock" the CAD document 

 "Unlock" the CAD document 

 

For further information please see the manual "CAD design supported by PRO.FILE". 

 

Until now, the designer was able to make local changes, without being actively or 

directly informed about possible conflicts with CAD documents saved in PRO.FILE. 

PRO.FILE now recognizes local changes. The integration evaluates the saving processes 

of the CAD system and displays a dynamic lock dialog:  

 You can select the CAD 

documents to be locked 

via the checkboxes.  

 With <OK> the 

locking is confirmed.  

 

Dynamic lock 

dialog with 

PRO.FILE 
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5.3.1 Starting your changes: "Lock" the CAD document 

If a plant project, sub-project or drawing is to be edited, it has to be locked by the user! 

 

 

Function call: 

"PRO.FILE" => "Edit" => "Lock/Unlock" => "Lock" 

 

1. Go to the "PRO.FILE" menu in AutoCAD Plant 3D. 

2. Select "Edit" => "Lock/Unlock" => "Lock". 

 The dialog screen 

for locking the 

loaded CAD 

documents is 

displayed.  

(Information on the 

functions and status 

information can be 

found in the 

chapter "The 

document list"). 

 

3. Select all documents you want to lock. To do so, activate the 

checkboxes for the desired documents.  

4. Confirm your selection with <OK>. 
 

With this "Lock" command, the access permissions of the user to edit the document are 

checked, and the document is locked so that other users cannot edit it. 

Once the CAD document is locked, it can be edited. The changes can be saved back to 

PRO.FILE via the function "Save" of the integration. 

 

 

Attention: Editing in the team 

It is recommended to lock documents, which you open with the intention of editing, 

directly after opening. You must lock your CAD documents to make sure that your 

changes can later be saved back to PRO.FILE. 

Proceed as 

follows 
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5.3.2 "Unlock" the CAD document 

In analogy to the function "Lock" you can use the function "Unlock" to unlock documents 

that you have locked. 

 

 

Note: 

You can only unlock documents that have been locked by you. The right to unlock 

documents of other users can only be given to administrators. 

 

 

Function call: 

"PRO.FILE" => "Edit" => "Lock/Unlock" => "Unlock" 

 

1. Go to the "PRO.FILE" menu in AutoCAD Plant 3D. 

2. Select "Edit" => "Lock/Unlock" => "Unlock". 

 The dialog screen 

for unlocking the 

loaded CAD 

documents is 

displayed.  

(Information on 

the functions and 

status information 

can be found in 

the chapter "The 

document list"). 

 

3. To make the CAD documents saved in PRO.FILE available for other 

users again, select the documents that you want to unlock. To do so, 

activate the checkboxes for the desired documents.  

4. Confirm your selection with <OK>. 

 

 The lock flag for the selected CAD document is now removed. 

 

  

Proceed as 

follows 
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5.3.3 Lock/Unlock drawing 

In addition to the function "Lock/Unlock" from the category "Edit" of the integration 

menu, which relates to all components of the project, the area "Handle active drawing" 

also contains the function "Lock/Unlock". This function only relates to the active drawing 

within the current project. 

The behavior of the function for locking/unlocking drawings is identical to the function 

of the same name from the "Edit" category", with the difference that the lock/unlock 

dialog for this function only offers the currently active drawing for selection. 

 

5.4 Delete database relation 

 This function dissolves the connection between the current Plant project and the 

document description in PRO.FILE. The projectthus no longer has a PRO.FILE 

connection. The project is now treated as a locally saved Plant project and marked 

accordingly in the Workcenter. 

The current project can be changed in AutoCAD Plant 3D and saved again in PRO.FILE 

with a new name and document ID. 

The "old" project still exists in PRO.FILE. The function "Delete database relation" does not 

delete any documents. 

 

 

Function call from the PRO.FILE menu in AutoCAD: 

"PRO.FILE" => "Edit" => "Delete database relation" 

 

1. Go to the "PRO.FILE" menu in AutoCAD Plant 3D. 

2. Select "Edit" => "Delete database relation". 

 The message, that this will remove 

the database relation of the entire 

project (including all its components) 

is displayed. 

 

3. Confirm this message with <OK>. 

 The PRO.FILE connection for the entire project is now successfully dissolved. 

 The selected CAD files are now local and no longer have a PRO.FILE connection. 

Changes to these files are not saved in PRO.FILE! 

To save the CAD data again in PRO.FILE, use the save function of the integration as 

described in the chapter "Save Plant project: Saving CAD objects for the first time". 

  

Proceed as 

follows 
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5.5 Make pipe specification available 

With the integration PRO.FILE – AutoCAD Plant 3D, it is possible to save the pipe 

specifications to be used centrally in PRO.FILE. The advantage is that the usage of such 

specifications can then be referenced by the various projects, so that these do not have 

to be saved anew for each project. For this, the administration of pipe specifications in 

PRO.FILE has to be activated. 

If the pipe specifications are managed centrally in PRO.FILE, you can use the function 

"Make pipe specification available" within a AutoCAD Plant 3D to use it within your 

project. The desired specification is then selected in PRO.FILE and copied to the project. 

 

 

Note: 

To be able to use the function "Make pipe specification available", the administration 

of pipe specifications in PRO.FILE has to be activated. Furthermore, the SpecSheets 

have to be imported to PRO.FILE. Please contact your administrator for further 

information. 

 

 

Function call: 

"PRO.FILE" => "Edit" => "Make pipe specification available" 

 

1. Go to the "PRO.FILE" menu in AutoCAD Plant 3D. 

2. Select "Edit" => "Make pipe specification available". 

 The Checkout wizard 

displays the 

PRO.FILE GUI as it 

was used the last 

time. The document 

of the desired pipe 

specification 

(SpecSheets are 

packed in zip files) 

can now be selected 

to be opened in 

AutoCAD Plant 3D. 

The behavior of the 

wizard corresponds 

to the normal 

"Open" process (see 

chapter "Open: 

Loading documents 

from PRO.FILE into 

AutoCAD Plant 3D"). 

 

Proceed as 

follows 
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3. Confirm your selection via the <Open> button. 

 The transfer of the pipe specification to your 

project is confirmed. 

 

 The pipe specification can then be used for the 

creation of pipe routes on a drawing. 
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6 Display: Access to PRO.FILE information 

The areas "Display" and "Handle active drawing" of the integration offer different 

functions that give you direct access to PRO.FILE information on the current CAD 

drawing or the project/sub-project. 

Depending on which details you are 

interested in, you can use the different menu 

entries to access the information. 

This way, you can immediately access 

information stored in PRO.FILE on properties 

and classifications of the active CAD 

document as well as structure and usage 

information. 

 

 

 

The following information can be found in the area "Display": 

 The document list 

 Display: Information on a CAD document in PRO.FILE 

 Direct information in the dialog screens 

 More comfort: search and list functions in the dialog screens 

 Up to date or not: Display of status information 

 

Detailed information can be found in the following sub-chapters. 
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6.1 The document list 

The document list displays the local and PRO.FILE information on the currently active 

project. With the function "Document list" you can also see which documents (sub-

projects, drawings) are currently used in your plant project. 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Display" => "Document list" 

 

When the function is used, the document list is displayed: 

 

You find the following information: 

 The documents contained in the project that are in your local working folder. 

 Information relating to the status of the CAD documents – both local as well as the 

PRO.FILE status. 

 

The document list also contains – as all other dialog screens of the integration do – 

different search and list functions (see chapter "More comfort: search and list functions 

in the dialog screens"). 
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6.2 Display: Information on a CAD document in PRO.FILE 

The areas "Display" and "Handle active 

drawing" of the integration offer different 

functions that give you direct access to 

PRO.FILE information on the current CAD 

drawing and part master record. 

 These menu entries directly access 

the information on the CAD 

document currently active in 

AutoCAD Plant 3D. 

 The individual menu entries allow a 

targeted access to the required 

information without having to search 

in PRO.FILE. 

 After a function is used, PRO.FILE 

opens and displays the selected 

view. 

 Within the displayed lists and forms, 

you can make use of all available 

PRO.FILE functions.  

 

 

 

Function call from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Display" => "…" 

"PRO.FILE" => "Handle active drawing" => "…" 

 

 

Note: 

Please note that these display functions can only be used if the CAD drawing is already 

known (i.e. saved) in PRO.FILE. 

If you have made changes to your file locally and have not saved these changes back 

to PRO.FILE, information resulting from these changes are not yet visible in PRO.FILE. 

 

The following views are available for project documents: 

 

Displays the structure overview of the part to which the current project is attached in 

PRO.FILE. 

 

Displays the part master record form of the current project in PRO.FILE. 

Part structure 

Part form 
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The functionality for bills of materials is not available in the current version of the 

integration. 

 

With this function you can display the list of documents belonging to the active project 

in PRO.FILE. 

 

With this function you can see which documents (sub-projects, drawings) are used within 

your project. 

 

Displays the document description form of the current project in PRO.FILE. 

 

The following views are available for drawings: 

 

With this function you can display the list of documents belonging to the active project 

to see the current local status as well as the PRO.FILE status of the documents. 

 

With this function you can display the list of documents belonging to the active drawing 

in PRO.FILE. 

 

With this function you can see which documents (part drawings) are used within your 

drawing. 

 

Displays the document description form of the current drawing in PRO.FILE. 

 

Shows a list of objects, in which the current drawing is being used. 

  

Bill of materials 

Document list 

PRO.FILE 

Document 

structure 

Document form 

Document list 

Document list 

PRO.FILE 

Document 

structure 

Document form 

Document 

usageFehler! 

Textmarke nicht 

definiert. 
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6.3 Direct information in the dialog screens 

For the functions lock, 

unlock and document list, 

dialog screens are 

displayed. 

 

These offer the following 

functions: 

 

 You can switch between list and structure display. 

 Via the buttons of the list functions you can make searches and filter the displayed 

objects (see the following chapter "More comfort: search and list functions in the 

dialog screens"). 

 The lists contain status information for each of the listed objects (see the following 

chapter "Up to date or not: Display of status information"). 

 

6.3.1 More comfort: search and list functions in the dialog screens 

The dialog screens of the PRO.FILE AutoCAD Plant 3D integration contain different 

search and list functions, as known from the PRO.FILE GUI: 

 

 

Via these buttons, the following functions are available: 

  Select all rows: 

With this button, all rows of a list are highlighted. 

  Invert selection: 

With the <Shift> key pressed down, it is possible to select whole areas of a list, 

with the <Ctrl> key pressed down, you can select several individual rows. The 

button "Invert selection" can be used to select everything that is not selected and 

unselect everything that was selected. 
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  Hide selected rows: 

If several rows of a list are selected, these rows can be hidden from the list with this 

button. 

  Search in all columns / Search in active columns: 

In order to be able to perform a targeted search for terms in the list, the user first 

has to select whether the search is to be carried out across all columns in the list or 

only for a specific column in the list.  

 : The search is performed across all columns in the list.  

  The search is performed for the active column only. A column is 

activated by clicking the respective column header.  

 Define Filter pattern / Filter: A character string can be entered 

into the entry field located within the icon bar. Here you can use the already 

described wildcards/meta characters. 

The search for the entered character string is started using the  icon.  

If the search pattern is found, all matching data records are highlighted.  

 Next found pattern:  

This icon is used to once again compare the entered filter pattern with the columns 

that are to be searched. The next data record found is highlighted. 

  Show hidden rows: 

If rows of a list have been hidden, this button can be used to display them again. 

  PRO.FILE list selection: 

The entries of the selected rows are selected and opened in a list in PRO.FILE. This 

ways you can immediately view the stored information without further selection. 

 

6.3.2 Up to date or not: Display of status information 

The document list - as all other dialog screen of the integration - contain three columns 

for displaying the status of the CAD data: 

 Info: Shows an icon for the data status. If you hover over the icon with the mouse 

pointer, a tool tip with more information is displayed. 

 : Displays the status of the CAD data in the local work folder of the Workcenter. 

 : Displays the status of the CAD data in PRO.FILE. 
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These columns may contain the following: 

Info  Local  PRO.FILE  Description 

 

new unknown The file is new and unknown in PRO.FILE. 

 

unchanged unknown The file is locally unchanged but comes from a 

different instance of PRO.FILE and can 

therefore not be saved back to the current 

instance. 

 

changed unknown The file is locally changed but comes from a 

different instance of PRO.FILE and can 

therefore not be saved back to the current 

instance. 

 

unchanged unchanged 

locked 

The file is locally unchanged and exists in the 

same form in PRO.FILE. The file is locked by a 

different user and can therefore not be saved 

back. 

 

unchanged changed The file is locally unchanged but has been 

modified in PRO.FILE after it has been copied 

locally and can therefore not be saved back. 

 

unchanged changed 

locked 

The file is locally unchanged but has been 

modified in PRO.FILE after it has been copied 

locally and can therefore not be saved back. 

 

changed unchanged The file is locally changed but has not yet been 

saved back to PRO.FILE. 

 

changed unchanged 

locked 

The file is locally changed. It is locked by a 

different user and can therefore not be saved 

back. Local changes may get lost. 

 

changed changed The file has been modified both locally and in 

PRO.FILE. The local changes cannot be saved 

back. 

 

changed changed 

locked 

The file has been modified both locally and in 

PRO.FILE. The local changes cannot be saved 

back. 
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7 Extras: The Workcenter 

The Workcenter supports you in the administration of components loaded from 

PRO.FILE and saved locally. 

 

 

Starting the Workcenter from the PRO.FILE menu in AutoCAD Plant 3D: 

"PRO.FILE" => "Extras" => "Workcenter" 

 

You can specify a work folder for each project, display it in Microsoft Explorer, lock and 

unlock components, get detailed information on parts, documents and bills of materials 

or delete individual CAD document from your work folder. 

Further information can be found in the manual "CAD design supported by PRO.FILE". 

 

 

Attention when working with several work folders: 

Please be careful when working with several work folders. It may happen that the 

loaded CAD document has loaded components from work folder A as well as from 

work folder B. When deleting files from one work folder, make sure that these 

components are not referenced by documents in a different work folder. To prevent the 

loss of data, you should only delete CAD documents that are saved in PRO.FILE. 

 

7.1.1 Workcenter functions 

The Workcenter is divided into two areas 

 on the left hand side you can find the directory structure of the Workcenter and its 

commands. 

 on the right hand side you can find the commands for all parts or other files 

currently retrieved from PRO.FILE that can be found in the working directory. You 

can also find here the status information as described in the chapter "Up to date or 

not: Display of status information".  
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The selected folder will be used as the new working 

directory. The current working directory is marked in bold. 

 

The view of the directory structure is updated. 

 

The selected folder is opened in the Windows Explorer. This 

gives you the possibility to use the usual Windows functions 

in order to delete, create or copy a working directory. 

 

 
Using the drop-down menu, you can retrieve the following 

information for marked objects: 

Structure of the parts  

Part form  

Usage of parts  

Bill of materials  

Document structure  

Document form  

Usage of documents 

 

The contents of the marked rows are read again from 

PRO.FILE and then displayed. 

 

The respective document is – depending on the user’s 

authorizations – locked or unlocked. 

 The marked documents are deleted from the directory. 

If the local status of at least one of the selected files is more 

recent than the one stored in PRO.FILE, a warning message 

will be displayed. 

 Starting from the selected work folder, all files that have 

been saved to PRO.FILE and that have not been modified 

locally since are deleted – including files in sub-folders. 

 
The display filter for the document list can be adjusted via 

this icon. This can be used to facilitat the finding of objects 

in large folders. 

 

Selected files can be replace by a newer PRO.FILE version 

(of the same file name). If version conflicts arise, the 

PRO.FILE dialog for the version selection is displayed. 

 

The functions for 

the directory 

structure 

The functions for 

the working 

directory 
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